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No one's too young... 
No one's too old... 
for Kid Pix 2! 

All kids are artists. Give them a box of crayons or a set of finger 
paints and they plunge right in, not worried about making messes 
or doing things "right." For them, art and play are inseparable; 
the process is as important as the result. Now at last, there's a 
program that takes advantage of kids' natural creative impulses 
and lets them use the computer in a playful way to create art 
that's uniquely their own. 

Kid Pix 2 is a paint and picture show program designed just for 
kids. It was created by a dad — Craig Hickman — for his three-
year-old son Ben. Craig discovered how much Ben loved to 
create art with the computer when he introduced him to a full-
featured paint program. But he also discovered that with the 
"big" program, Ben often got himself into frustrating situations. 
He accidentally launched desk accessories, moved windows, and 
made random menu selections. Craig decided to solve these 
problems by writing a paint program just for kids. 

Special Broderbund's Kid Pix 2 combines two great products: Kid Pix 
Features: and Kid Pix Companion. It's loaded with fun features — 

everything from crazy sound effects and patterns that burst into 
color to brushes that paint in wacky ways and SlideShow — a 
tool for making multimedia presentations with Kid Pix 2 
pictures. Yet it still retains all the natural, easy-to-use and kid-
proof features that Craig, responding to his experiences with his 
own son, built into the program. These features include: 

• A Small Kids Mode that allows you to turn off the menu bar so 
that young children can't open menus and make selections 
accidentally. 

• A drawing area that's visible all at once on the screen. No 
scroll bars needed to maneuver the picture. What you see is what 
you get when you print out. 



• Tools and tool options that are available right on the screen. 
The tools themselves perform with a minimum of fuss, and the 
options that go with them are new and exciting. 

• Text and numbers that can be added to pictures without using 
the keyboard. The program speaks the names of letters and 
numbers out loud as they're selected. You can even choose to 
have them spoken in Spanish. 

• Sound and visual effects that add fun while they stimulate 
creativity and reinforce learning for kids. 

• A menu of extra creativity starters. . . 

And what about you, the grown-up reading these words? Can 
you enjoy Kid Pix 2 , too? You bet! It's a fully-faceted paint 
program. You'll have fun using it with your kids. Then, after 
they're tucked away safely in bed, turn on the computer and play 
with it all by yourself. No one's too old or too sophisticated for 
Kid Pix 2 ! 

Kid Pix 2 was designed so that kids who aren't old enough to 
read can use most parts of it. That means you don't really need 
to study this manual to operate the program. In fact, lots of the 
fun with Kid Pix 2 comes from discovering for yourself what 
the tools and their options do. This manual can serve as a handy 
map for your explorations. It shows the general lay of the land, 
highlights points of interest you might miss, and rescues you if 
you get lost. There are five main sections: 

Getting Started tells you how to start the program, and fills you 
in on technical details. 

Working With Kid Pix 2 gives you an overview of the program. 
It tells you, quickly and simply, everything you need to know to 
use Kid Pix 2 . 

About Kid Pix 2 Tools explains how each drawing and special 
effects tool works. 

About Kid Pix 2 Menus describes each feature of the Kid Pix 2 
menus. 

Let's Make a Slide Show explains how to use the SlideShow 
program to make fun multimedia picture shows. 

About this 
M a n u a l : 







© 
Getting 
Started 

W h a t you'll • Kid Pix 2 User's Guide 
find in this 
p a c k a g e : • Kid Pix 2 Disks (Includes QuickTime and QuickTime movies!) 

• Installation Instruction Card 

W h a t y o u • ^ny Macintosh, monochrome or color, that satisfies the 
will need: following requirements 

• A Hard Disk Drive is required 

• System 6.0 and higher 
• System 6.0.7 and higher for sound recording and QuickTime 
features 

• System 6 requires 1 MB RAM for monochrome systems 
• System 6 requires 2 MB RAM for color systems 
• System 7 requires 2 MB RAM for monochrome systems 
• System 7 requires 4 MB RAM for color systems 

• QuickTime features require 4 MB RAM on all systems 

• To switch between SlideShow and Kid Pix 2, you will need 
3 MB of available RAM. Choose "About this Macinosh" from 
the Goodies menu to see how much RAM you have available. 

• Monochrome or Color Printer 

• Sound recording capability - either built-in or via the 
Macromedia, Inc. MacRecorder™ for systems without built-in 
sound recording capability 





Working 
with 
Kid Pix 2 
Starting the Kid Pix 2 program is like entering your very own 
artist's studio. Everything you need is at hand — brushes, paints, 
pencils, erasers, interesting bits of this and that. Nothing is 
difficult to use. A three-year-old can create a wonderful drawing. 
An eighty-year-old can, too. And everyone has fun in the 
process. 

The best way to start using Kid Pix 2 is to plunge right in. 
There's no "right" way to do things, no correct sequence to 
follow. You can't make a mistake, because there are no mistakes 
to be made. 

This section of the manual and the sections on tools and menus 
/ N that follow will tell you everything you need to know to use 

Kid Pix 2. Read them through before beginning, if that's your 
style. Or simply refer to them if you get stuck. 

The Kid Pix 2 The Kid Pix 2 Drawing Screen appears when you start the 
D r a w i n g Screen: program. The drawing area is like a blank sheet of paper. You 

draw on it by first selecting a tool and tool options, then holding 
the mouse button down and moving the mouse. Nothing is 
hidden from view. When you print out your drawing, everything 
you see in the drawing area will appear on the printed page. 



The Kid Pix 2 Drawing Screen 
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Menus are contained on the menu bar at the top of the screen. 
They let you perform various functions, such as editing, saving 
and printing your work. The Goodies and Switcheroo menus 
provide access to special features of the Kid Pix 2 program. 

• To open a menu and choose a command, point to the menu 
you want and press the mouse button. Move the pointer down 
the menu to the command you want, then release the button. 

Kid Pix 2 drawing tools are at the left of the screen. Each tool 
has its own set of options which are displayed at the bottom of 
the screen. The pointer will change shape, depending on the tool 
selected. 

• To select a tool, simply point to the tool you want and click the 
mouse button. The selected tool will be highlighted and its 
options displayed. 

Tool 
Opt ions 

4 
9 

Color 

0 

9 

The tool options at the bottom of the screen change, depending 
on the tool selected. The options vary the basic behavior of the 
tool. They control such things as line width and pattern, let you 
draw in a variety of styles, and erase in different ways. The tool 
options are one of the most appealing things about Kid Pix 2. 
You'll have fun playing with them even if you're not trying to 
create a finished drawing. 

• To select a tool option point to the one you want and click the 
mouse button. The selected option will be highlighted. 

A 0! at the end of a set of options indicates that more are 
available. Click Rj to see more. 

Kid Pix 2 takes advantage of the full range of color available on 
your Macintosh system. If you are using a color system, a color 
palette will appear at the left of the screen beneath the tools. If 
you are using a monochrome system, the color palette will not 
appear. 

The current color is displayed in a box at the top of the palette. 
This is the color the selected tool will use to draw. You can select 
a new current color whenever you want. Some tool options 
produce multi-colored effects. 



• To select a current color, point to the color you want and click 
the mouse button. The selected color will appear in the current 
color box. 

You can extend your range of color choices by selecting colors 
from the Apple Color Picker. 

• To use the Apple Color Picker, hold down the Option key while 
clicking on the current color. The Color Picker will appear. 
Click the color you want. The color you've selected will appear 
in the current color box. (Note: Colors chosen from the Apple 
Color Picker will not replace the colors in the Kid Pix 2 palette.) 

Select new color. 

Hue 

Saturation 
Brightness 

Red 
Green 

Blue 

no 
S o u n d Kid Pix 2 has a dazzling array of sound effects. Paint gurgles as 

it pours. Letters speak their names, firecrackers explode, pictures 
and symbols fall into place with a satisfying click. If you are 
using a system with a microphone, you can even record spoken 
messages to accompany your creations. 

Kid Pix 2 tool sounds are designed to stimulate creativity and 
reinforce learning. But sometimes a little peace and quiet is in 
order. You can adjust the sound volume by using your 
Macintosh control panel or you can turn off tool sounds entirely. 

• To turn off tool sounds, simply choose "Tool Sounds" from the 
Goodies menu. To turn them back on, choose "Tool Sounds" 
again. 

• To record a spoken message, choose "Record" from the 
Goodies menu; to play back a recorded message, choose "Play." 
For complete details on recording and playing back messages, see 
Goodies menu, page 35-36. 

Smal l 
l^.j s Small Kids Mode is a very useful feature of Kid Pix 2. When it's 
M o c j e in effect, the full menu bar at the top of the screen disappears so 

there's no chance of opening a menu and choosing an item 



accidentally. If you are using a system with Multifinder, or 
System 7.0 there is a "bib" around the screen so that the user 
cannot accidentally open a background application. 

You'll probably want to use Small Kids Mode whenever younger 
children are working with the program. It's a simple way of 
preventing them from getting stuck in situations they don't know 
how to handle, and of protecting other applications on your 
system. 

Note: You cannot open or save a file or quit while you are using 
Small Kids Mode. You will need to turn Small Kids Mode off 
before you can perform any of these functions. 

• To turn Small Kids Mode on, simply choose "Small Kids 
Mode" from the Goodies menu. The full menu bar will be 
replaced by a short Kid Pix 2 menu. 

• To temporarily view and select items from the full menu bar, 
choose "Show Menu Bar." The full menu bar will disappear 
when drawing is resumed. 

• To turn off Small Kids Mode, choose "Show Menu Bar" from 
the Kid Pix 2 menu. Then open the Goodies menu and choose 
"Small Kids Mode" again. 

S a v i n g a n d 
Retrieving 
D r a w i n g s 

You can save Kid Pix 2 drawings and retrieve them later to print 
out or work on again. Don't worry about losing your creations. 
Kid Pix 2 always gives you a chance to save before you start a 
new drawing or quit the program. Kid Pix 2 will save your 
drawings in the PICT format. 

Note: If Small Kids Mode is turned on, you'll need to turn it off 
before you can save or retrieve a drawing. 

• To save a drawing, choose "Save" from the File menu. Type in 
a name for your drawing, then click "OK" . You can save any 
changes you make to the drawing by simply choosing "Save" 
again. It's a good idea to save your work periodically, to guard 
against loss due to system or power failure. 

• To save a previously named drawing under a different name, 
choose "Save As . . ." from the File menu. Type in a new name 
for the drawing, then click "OK" . The drawing will be saved 
under its new name; the original drawing will remain saved 
under the original name. 



• Sounds you have recorded with your microphone or 
MacRecorder will be automatically saved with your drawing. To 
save a drawing without its recorded sound, click in the " Save 
with Sound" box to deselect this option. Pictures saved without 
recorded sounds require less disk space. 

• To retrieve a saved drawing, choose "Open" from the File 
menu. Select the drawing you want from the list that appears on 
the screen. 

• Pictures saved with recorded sounds will automatically play the 
sounds upon opening. To open without sound playing, click in 
the "Open with Sound" box to deselect that option. 

Starting 
a N e w 
D r a w i n g 

You can start a new drawing whenever you want. It's as easy as 
flipping to a clean page in a drawing pad. 

• To start a new drawing, choose "New" from the File menu. 
You'll be given a chance to save changes made to the current 
drawing. Then the area will be cleared and you're ready to start 
drawing again. Note: If Small Kids Mode is turned on, you'll 
need to turn it off before you can start a new drawing by 
choosing "New." 

• If you don't care to save your drawing, you can start a new 
drawing simply by erasing the screen using one of the eraser 
tools. 

Importing 
Pictures: 

You can import a wide variety of computer-generated images — 
everything from clip art, digitized photos, Photo CD files, Print 
Shop graphics, or pictures you've created with other paint 
programs — to use in your Kid Pix 2 creations. You can do this 
either by using the Scrapbook desk accessory or by simply 
opening any graphics file stored as PICT, a common Macintosh 
graphics file format. 

Note: For complete information on storing images in the 
Scrapbook, see your Macintosh manual. 

• To import a picture stored in the Scrapbook: 

Open the menu and choose "Scrapbook." Select a stored 
image by clicking the scroll arrows until the image you want 
appears on the screen. 



Open the Edit menu and choose "Copy." The image you 
selected from the Scrapbook will be copied to the Clipboard. 
Close the Scrapbook by clicking the square in the upper left 
corner. 

Choose "Paste" from the Edit menu. The image from the 
Clipboard will appear on your Kid Pix 2 drawing. Move the 
mouse without pressing the mouse button to position the image. 
When you have it where you want it to be, click the mouse 
button to paste it in place. 

• To open a picture stored in the PICT file format, choose 
"Open" from the File menu. Select the picture you want from 
the list that appears on the screen. A warning will appear to 
remind you to rename your PICT file before saving changes 
made in Kid Pix 2. 

Note: Some cropping of the PICT picture may occur, so that it 
will fit in the Kid Pix 2 drawing screen. 

Printing Everything you create with Kid Pix 2 can be printed out. If you 
have a color system and color printer you can print your drawing 
in color. 

Before attempting to print, be sure that your printer is connected 
properly to your computer. Choose "Print" from the File menu. 

Select a printout size from the four options and the number of 
copies you want to print. 

When you are ready, click "Print" and your drawing will be 
printed out. 

If you would like to set up your printer options yourself, click the 
Manual button. The changes you make in Manual will remain 
until you restart Kid Pix 2. 

Quitting the When you're done using Kid Pix 2, leave the program in an 
P r o g r a m orderly way by choosing "Quit" in the File menu, rather than 

just shutting off your computer. Kid Pix 2 will give you a 
chance to save any work you have done. 

Note: If Small Kids Mode is turned on, you'll need to turn it off 
before you can quit the program. 





About 
Kid Pix 2 
Tools 
Kid Pix 2 tools come with a wide variety of options that are 
displayed at the bottom of the screen whenever a tool is selected. 
Some tools have several sets of options. A 0 icon at the end of 
a set indicates that more options are available. All of the tool 
options behave differently if you press the Option, Command or 
Shift keys during use. These are marked here with a star (*) . 
Experiment to find out what they do. 

• To select a tool, point to the one you want and click the mouse 
button. 

• To select a tool option, point to the one you want and click the 
mouse button. 

To see more tool options, click the icon. 

W a c k y 
Pencil Wacky Pencil 

The Wacky Pencil draws free-form lines. Select line widths, line 

styles, and line patterns from the Options bar. The option 

produces a tint effect, like a water color wash, that's great for 

coloring Kid Pix 2 "hidden pictures." If you are using a 

monochrome system, the |4fr| option produces a half-tone effect. 

The option cycles through a color palette while it draws, 

giving a "rainbow" effect. On monochrome systems, the brush 

cycles through a palette of greys. There are two sets of line 

options, giving you square or circle-shaped lines. 



Line 

The line tool draws straight lines. Select line widths and line 
patterns from the Options bar. The <jjjjĵ  option produces a ray 
effect that inverts the color of 
whatever it passes over. 

• To draw perfect horizontal, vertical, or 45 degree angle lines, 
press the Shift key while using the tool. 

Rectangle* 

The rectangle tool draws rectangles in various patterns. Select 
the pattern you want from the Options bar. For a transparent 
rectangle, use the first pattern; for an opaque white rectangle, 
use the third pattern. The <jjĵ  option produces a rainbow 

rectangle. 

• To draw a rectangle without a black border, press the Option 
key while using the tool. 

• To draw a perfect square, press the Shift key while using the 
tool. 

Option + fills a rectangle with shades of gray. 

O v a l * 

The oval tool draws ovals in various patterns. Select the pattern 
you want from the Options bar. For a transparent oval, use the 
first pattern; for an opaque white oval, use the third pattern. 
The option + produces a rainbow circle. 

• To draw an oval without a black border, press the Option 
key while using the tool. 

• To draw a perfect circle, press the Shift key while using the tool. 

• Option + <jjj£ fills a circle with shades of gray. 

W a c k y 
Brush Wacky Brush 

The Wacky Brush is lots of fun. It paints in a variety of ways, 
depending on the tool option you select. There are two sets of 
Wacky Brush tool options. If you are using a color system, most 
paint in the current color, but some are multi-colored. 



Wacky Brush Options 

Here's what the Wacky Brush tool options do. Those marked 
with a star (*) change a bit when used with the Option, Control, 
Shift or Command keys. Try them and see. 

Leaky Pen* 

Your pen's sprung a leak. Ink soaks into your "drawing pad' 
whenever the pen stops moving. 

Z i g - Z a g * 

Bet you can't draw a straight line with this one! 

D o t s * 

Lots and lots of dots. 

Bubbly* 

Soda pop time. Plenty of bubbles and fizz. 

Pies* 

Everyone's after a bigger slice of the pie. 

Echoes* 

Circles within circles within circles. 
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Mill Northern Lights* 

o cP 
Colorful aurora borealis. Can be horizontal or vertical depending 
on which direction you move the brush. 
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Fuzzer* 

"Fuzzes" whatever it moves over. 

O 

o o 

I v— yl Magnifying Glas s* 
v * 

J Enlarges whatever is under it. Move it around your drawing like 
~Q Sherlock looking for a clue. °! 

o 

Spray Paint* 

| | J O ^ q Sprays a line of mist. 
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Pine Needles* 

Paints a trail of pine needles. 

3 - D * 

Draws a line with a 3-D effect. 

Kaleidoscope* 

,o 
o o f 

Kaleidoscope effect. Perfect symmetry wherever you move the 
brush. 

> n 5 * ° « o . n . o « o . o 
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I ~ I Drippy Paint* 

Messy paint drips as you draw. 

1 Connect-The-Dots* 

Make a connect-the-dots picture. Points are numbered as you 
draw. When you release the mouse button, the line connecting 
the dots disappears. 

• To keep the line between the dots, press the Option key while 
you drag the mouse. 

• To re-start the number sequence, click the Connect-the-dots 
icon again. 

• To space dots farther apart, click each dot into place 
individually. When you do this, a connecting line will not 
appear. 

ABC 
Alphabet L ine* 

The e. e. cummings effect. Paints with a line of alphabet letters 
or with words of your own creation. 

• To enter your own words, numbers or symbols, select 
"Alphabet Text" from the Goodies menu or double-click the 
icon. (Note: Double-clicking won't work if you're using Small 
Kids Mode.) Type words or a new letter, number or symbol 
sequence in the box that appears on the screen. 

Swirl* 

Lines swirl from the tip of the brush as you paint. 



Invert* 

This brush inverts the color of everything it passes over. 

Geometry* 

Produces random geometrical drawings. Click the mouse button 
to start the drawing. 

* To make a giant drawing, hold down the Option key as you 
click. 

Trees* 

Generates "fractal" trees, each one different from the next. Click 
the mouse button to start a tree. 

* To make a giant tree with many branches hold down the 
Option key as you click. 

• To stop before the tree is finished, press the Command and 
Period keys. 

Caterpillars* 

Symmetrical caterpillars crawl around the screen. 

d Splatter Paint* 

The Jackson Pollock (or cafeteria after a food fight) effect 

* Use the Option key to turn the circles into triangles. 
* Use the Command key to make the splatters larger. 
* Use the Shift key to make outlines. 

00 The Looper* 

Uh oh. Looks like the kitten's gotten into the yarn. 



11—=jj I Roll-The-Dice* 
Casts randomly numbered dice on your drawing. 

Picture Brushes 

Paint with pictures. 

A Galaxy of S tars* 

Lots of Hugs and X ' s * 

9 A Full Deck of C a r d s * 

A Shapes and More Shapes* 

Electric 
M ixer Electric Mixer 

Transforms your drawing in a variety of crazy, mixed-up ways. 
To set mixer effects in motion, click the tool option you want, 
then click on your drawing. 

Night and Day 

Changes black to white and white to black. Inverts colors if 
you're using a color system. Click to make the change. Click 
again to reverse it. 



I Splash! 

Big blobs of paint are splashed on your drawing. The longer you 
hold the mouse button down, the more blobs appear. 

Checkerboard 

Gives your drawing a checkerboard effect. Click to get the 
transformation going. Click again to get your original drawing 
back. 

Wallpaper* 

Makes multiple copies of a section of your drawing to create a 
tiled, or wallpaper, effect. The pattern changes, depending on 
what the pointer moves over. 

118 ,. J 

i i l i i i i Venetian Blinds 
Slices your drawing into horizontal stripes. Click repeatedly to 
rearrange the pattern. 

The Outliner 

Outlines every line in your drawing. Click repeatedly to create a 
series of fascinating effects. 

Shadow Boxes 

Copies sections of your drawing and places them in overlapping 
boxes on the screen. Click repeatedly to produce more boxes. 



Zoom In 

Zooms in on a portion of your drawing, making it several times 
larger. Click repeatedly to zoom in closer and closer. 

Broken Glass 

Shatters your drawing into many jagged pieces. 

Picture In A Picture 

Shrinks a copy of your picture. Hold down the mouse button to 
paste it anywhere. 

The Highlighter 

Highlights everything. 

Pattern Maker 

Turns your picture into a pattern. 

Wrap Around* 

Wraps your picture around from one end of the screen to the 
other. 

* The Option key wraps the picture from top to bottom. 



Snowflakes And Rain D r o p s * 

Snowflakes fall on your picture. * Hold down the Option key to 
melt snowflakes into raindrops. 

Paint 
C a n Paint Can 

Fills with the selected paint pattern. 

Eraser 
Erasers 

Lets you erase all or part of your drawing in a variety of 
interesting ways. 

• Q 
Eraser Sizes 

Erasers range from large to small. Choose whichever size or 
shape you need to get the job done. 

Firecracker* 

Clear the screen in one big blast. Select this option, then click on 
your drawing to start the explosive reaction. 
* To Freeze the Firecracker effect, press the Option key. 

Hidden Pictures* 

Kid Pix 2 has secrets. Uncover hidden pictures by selecting this 
option and erasing. To uncover another hidden picture, click the 
option again and continue to erase. 
* To enlarge the erasing area, press the Option key. 
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O White Circles 

Big white circles gobble up your drawing. Hold down the 
button until everything's gone. 

Slip-Sliding Away 

Sliding doors erase your drawing. 

An exclamatory end to it all! 

Fade Away* 

Watch your picture fade away. 

Drop Out 

Chunks of your picture drop out until nothing is left. 

Black Hole 

The black hole swallows up everything! 

Count Down 

Count down to today's date and time 



Sweep* 

Spins and sweeps your picture away. 

Text 
Text* 

-iiZfr 

MY TFaP TO THE MUSEUM 
My whole family went to 
the museum last week. 

Place letters, numbers, and symbols wherever you want on your 
drawing. When you select a letter, a voice speaks the letter's 
name in English or in Spanish. Click to stamp the letter you've 
selected in place on your drawing. If one letter is stamped close 
to another, it will align itself to the baseline of the previously 
placed letter. You can also enter text from the keyboard. 

* To turn off the baseline feature, press the Option key as you 
stamp the letter in place. 

* To enter text from the keyboard, choose "Type Text" from the 
Goodies Menu. Position the pointer where you want the text to 
appear on your drawing and click. Type in the text you want. 
Change the color or choose a different font before clicking the 
mouse again. 

Rubber 
S t a m p s 

Rubber Stamps* 

Place "rubber stamp" pictures on your drawing. Eight sets of 
rubber stamps are available. Stamps are multi-colored if you are 
using a color system. Click to stamp the picture you've selected 
in place. To place many rubber stamp pictures on your drawing, 
hold the mouse button down and move the mouse. 

• To double the size of a stamp, press the Option key while 
stamping the picture in place. 

• To triple the size of a stamp, press the Shift key while stamping 
the picture in place. 

• For gargantuan stamps, press both the Option key and the Shift 
keys while stamping the picture in place. 

Note: Gargantuan stamps won't work on 9" monochrome 
monitors. 



• To edit or add new stamps, use the "Edit Stamp" option on the 
Goodies menu. Or simply double-click the Rubber Stamp icon. 
(Note: Double-clicking won't work if you are using Small Kids 
Mode). 

Hint: Move your mouse slowly to make a stamp brush. 

M o v i n g 
V a n Moving Van* 

Moves a selected section of your drawing from one spot to 
another. Choose the size and shape "moving van" you need. 
Position the van over the section you want to move. Move the 
section by holding the mouse button down and moving the 
mouse. Release the button when the section is where you want it 
to be. 

• To move a copy of the selected section, hold the Option key 
down while you move the mouse. 

The L__ J option gives you an adjustable-size moving van that 
you can use to capture and move any section of the drawing you 
want. You can also cut, copy, clear, or paste the captured 
section, using the commands on the Edit menu. 

rift] 
• To capture a section, select the | _ _ J option. Then position the 
cross-shaped pointer at the upper-left corner of the section you 
want. Hold the mouse button down and move the mouse until 
the section is captured. Release the mouse button. 
• To move the captured section, hold the the mouse button down 
and move the mouse. Release the button when the section is 
where you want it to be. 

• To apply editing commands to the captured section, open the 
Edit menu and choose the command you want. 

The 
U n d o 
G u y The Undo Guy 

A friend in need. The handy Undo Guy comes to your rescue 
whenever you do something you didn't want to do. Click his 
anxious face and the results of your last action will immediately 
disappear. (Works the same as "Undo" on the Edit menu.) 





About 
Kid Pix 2 
Menus 
Kid Pix 2 menus include standard Macintosh features. The File 
menu allows you to open files, close files, save your work, print, 
and quit the program; the Edit menu allows you to perform basic 
editing functions. If you're not very familiar with the Macintosh, 
you may want to consult your Macintosh manual for a complete 
discussion of how the menus work. 

• To open a menu, point to the menu you want and hold the 
mouse button down. 

• To choose a menu item, move the mouse until the option you 
want is highlighted; then release the mouse button. 

Lets you start a new Kid Pix 2 file. Starting a new file is like 
getting a clean sheet of drawing paper. You will be given a 
chance to save changes to your current drawing before the new 
file is opened. 

O p e n . . . §€0 

Lets you open a previously saved Kid Pix 2 file. Select the file 
you want from the list on the screen. If the file has a recorded 
sound message attached, you'll be given the option of opening it 
without the sound. 

• C l o s e :#:W 

Lets you close the current file. 

File 
M e n u f N e w 3§N 



S a u e 

Lets you save a drawing. If the drawing has a recorded sound 
message attached, you'll be given the option of saving it without 
the sound. 

S a u e fls... 

Lets you save the current drawing with a different name. If the 
drawing has a recorded sound message attached, you'll be given 
the option of saving it without the sound. 

P r i n t . . . 3€P 

Lets you choose the size and number of copies you want, then 
prints out your picture. 

Quit :#:Q <2 
Lets you leave the program. You'll be given a chance to save 
changes to the current drawing before you quit. 

Edit 
M e n u U n d o % Z 

Undoes your last action. 

C u t :#:« 

Lets you cut a captured section from your drawing and place it 

on the Clipboard. Use the T f l j option under the Moving Van 

tool to capture the section. 

C o p y 36 C 

Lets you copy a captured section of your drawing to the 
Clipboard. Use the option key under the Moving Van tool to 
capture the section. 



P a s t e 

Lets you paste whatever is on the Clipboard onto your drawing. 

When you choose "Paste", whatever is on the Clipboard will 
appear on your drawing along with a pointer shaped like a paste 
jar. Without holding down the mouse button, move the mouse 
until the Clipboard selection is where you want it to be. Click 
the mouse button to paste the selection in place. 

C l e a r 

Lets you remove a captured section from your drawing. Use the 
option under the Moving Van tool to capture the section. The 
cleared section will not be placed on the Clipboard. To get it 
back, choose Undo before you do anything else. 

Goodies 
M e n u S m a l l K i d s M o d e 3§K 

Lets you turn off the full menu bar. Places a "bib" around the 
screen so that background applications cannot be accidentally 
opened. 

This feature is handy when younger children use Kid Pix 2. It 
eliminates the problem of a child straying into another 
application or accidentally opening a menu, selecting an item, 
and getting stuck in a situation — such as an editing or dialog 
box — that he or she may not know how to respond to. 

When you choose "Small Kids Mode", a special menu bar that 
looks like this will appear: 

Kid Pin 

• To temporarily view and select items from the full menu bar, 
choose "Show Menu Bar." The full menu bar will disappear 
when drawing is resumed. 

• To turn off the Small Kids Mode and restore the full menu bar, 
simply choose "Small Kids Mode" from the Goodies menu 
again. You will need to do this in order to open or save a file or 
quit the program. 



Edi t S t a m p . . . 3€E 

Lets you edit the "rubber stamp" pictures contained in Kid Pix 2. 
You can even create an entirely new stamp from scratch. To edit 
a stamp: 

• Select the Rubber Stamp tool. 

• Click the stamp you want to edit. 

• Choose "Edit Stamp" from the Goodies menu or simply double 
click on the stamp. (Note: Double-clicking won't work if you are 
using Small Kids Mode.) The Stamp Editor will appear. 

The current stamp is displayed in an enlarged version in the 
editing box. It is made up of many small squares called pixels. 
An actual-size version of the stamp appears in the upper-right 
corner of the Editor. Editing tools and the color palette (if you 
are using a color system) are displayed to the left of the editing 
box; control buttons are to the right. 

To edit the stamp: 

• Click the pixels you want to change. Black pixels change to 
white; white to black. 

If you are using a color system, clicking a pixel will change it to 
the current color; if it is already in the current color, clicking will 
change it to white. 



• Use the editing tools and control buttons as needed. 

Rotate 

Rotates stamp 90 degrees 

L H J Flip 

Flips the stamp from left to right and right to left. 

Undo 

Undoes your last action. 

Clear 

Clears the stamp from the Stamp Editor. Use this tool if you 
want to create an entirely new stamp from scratch. 

(Don't worry about losing the original stamp. The program 
always keeps a copy. You can get the original back whenever 
you want by clicking the Restore Original button.) 

Color Palette 

Works just like the color palette you use when creating a Kid 
Pix 2 drawing. 

Note: To select a color from the stamp itself (rather than the 
palette) hold down the Option key and click on an area of the 
stamp that contains the color you want. 

Restore Original 

Restores the original Kid Pix 2 stamp. 

On quitting Kid Pix 2, the program will ask you if you would 
like to save your stamps. But Kid Pix 2 always keeps a copy of 
the original stamp which you can restore at any time by clicking 
this button. 



Cancel 

Returns you to the Kid Pix 2 drawing screen without saving 
changes you have made to the stamp. 

Saves changes you have made to the stamp and returns you to 
the Kid Pix 2 drawing screen. 

IflBCl A l p h a b e t Tent . . . 3gfl 

Lets you enter new letters, numbers or symbols for the Wacky 
Brush Alphabet Line. 

When you select "Alphabet Text" a text entry box will appear. 

Enter new letters 

Once upon a time in a deep and dark forest, there liued a 
green moose. Nobody could see him because he matched 
s n I I I P I I m i t h thp t r p p s . HP m a s a npri i Innp ln m n n s p . 

• To enter new text, simply type in the letters, numbers, or 
symbols you want. You don't need to press Return at the end of 
a line. The text will cycle automatically from line to line. If you 
make a mistake, use the Delete key to move the cursor to the left 
and then type in your correction. 

• Click the OK button to save your text and return to the Kid 
Pix 2 drawing screen. 

• Click the Cancel button to restore the original text and return 
to the drawing screen. 

Choose "Type Text" from Goodies to type in text from your 
keyboard. Click on the screen where you would like to begin 
typing. 

OK 

OK 3 Cancel 

Note: or hold down Option while clicking on A tool. 



ô}) Tool S o u n d s 
Lets you turn off Kid Pix 2 sound effects. To turn tool sounds 
back on, simply select "Tool Sounds" again. 

R e c o r d S o u n d # R 

Lets you record a voice or other sound message (music, special 
sound effects, a poem or story) to accompany your drawing. 
You can save the drawing with or without the sound message 
attached. 

If you are using Kid Pix 2 with any Macintosh that comes with a 
microphone; or if you have a MacRecorder® and System 6.0.7 or 
higher installed on your Macintosh. The record feature is 
available. 

To record a message, choose "Record" from the Goodies menu. 
The Sound Input dialogue box will appear. 

<] 
Record Stop Pause Play Cancel 

:00 
seconds :32 

• When you're ready to start recording, click the Record button. 
Speak into the microphone. The seconds bar shows how much 
time has elapsed. If you want to pause, click the Pause button. 
Click the Record button to start recording again. 

• When you're done recording, click the Stop button. To play 
back your recording, click the Play button. If you're not satisfied 
with your message, click the Record button and do it over. 

• When you're satisfied with your recording, click Save. The 
sound message will be attached to your drawing. When you are 
ready to Save the drawing to disk, you'll be given the option of 
saving it without the sound message if you wish. 



P l a y S o u n d MM 

Lets you play a recorded message attached to a drawing. To play 
the message, simply choose "Play" from the Goodies menu. If 
no message has been attached to the drawing, "Play" will be 
grayed out. To interrupt a long recording and begin drawing, 
hold down the Command and Period keys, or press the mouse 
button. To speed up the sound, press the Option key. To slow 
down the sound, press the Shift key. 

Sound can only be recorded in Kid Pix 2 if you are using a 
Macintosh with a microphone or a MacRecorder and System 
6.0.7 or higher. System 6.0.7 is also required for playing back 
sounds. 

Note: Sounds recorded and saved with Kid Pix 2 on the 
Macintosh II series of computers cannot be played back on the 
Macintosh Plus, Macintosh SE, or Classic. 

M o r e 
About 
S o u n d 



Switcheroo 
M e n u 

S w a p S t a m p s s w a p s t a m p s . . . 

• Select Swap Stamps to swap Rubber Stamp sets. Click on a 
stamp set to highlight it, then click on OK to complete the swap. 

Once the swapping is complete, the new Rubber Stamps can be 
displayed by clicking on the Rubber Stamp tool on the Kid Pix 
drawing screen, ready for you to use in your Kid Pix 2 drawings 
and your DrawMe pictures. 

TIP: You can swap stamps at any time without changing stamps 
already placed in a picture. In this way you can include stamps 
from all three Kid Pix 2 sets in the same picture. 

S w a p Hidden 
Pictures 

S w a p Hidden Pictures. . . 

Switcheroo 

JtJt Swap Stamps . . . 

Swap Hidden Pictures. . . • 

DrawMe 

ColorMe... 

36F 

Wacky TLI... 

Play Motiie 

Switch to SlideShow 

• Select Swap Hidden Pictures when you want to swap the Hidden 
Pictures in Kid Pix 2. It works the same way Swap Stamps does. 
Pick the one you want, click on OK and the pictures automatically 
swap. 

Once the swapping is complete, the new Hidden Pictures will be 
available in Kid Pix 2 for you to use in your Kid Pix 2 drawings. 
Just click on the Hidden Pictures eraser tool that looks like this 

and start scrubbing away. m 
TIP: If you hold down the option key, the eraser will erase a larger 
area of your Hidden Picture. 
TIP: Use the Wacky Pencil option that looks like this 
color over a Hidden Picture without erasing any of it. 

to 

D r a w M e 
D r a w M e 

Here's a feature of Kid Pix 2 that will really put your imagination 
into high gear. Sometimes you know exactly what you want to 
draw; sometimes you want an idea for what to draw. DrawMe 
pictures are special projects that start you out with a blank screen 
and a talking computer! They give rich and colorful ideas in a 
crazy, madcap way. Here's what you do: 

• Be sure you're sitting down. 



• Select DrawMe from the Switcheroo Menu and get ready for one 
of the zaniest art assignments you have ever heard. DrawMes work 
by a process called Chaos Randomizing, where sentences that 
describe a fantasy scene are made up of smaller phrases that are 
freshly mixed and matched each time you select DrawMe, leading 
to literally thousands of suggestions! As the computer speaks to 
you, it writes down the words it is saying on the screen. You can 
hear the DrawMe again by selecting Play Sound (<H>-H) under the 
Goodies menu. You can get a new one by selecting DrawMe under 
the Switcheroo menu. Each DrawMe can lead to many a wild and 
zany picture, because each of the far-out scenes it describes can be 
drawn in a lot of different ways. 

• When you have completed your drawing, give it a title by 
selecting Save from the File Menu and entering the name that best 
describes what you have created. 

TIP: You can use one of the Kid Pix 2 erasers to erase the words 
the DrawMe puts onto the screen if you so desire. 

TIP: If your computer doesn't record sound, DrawMes are a good 
way to create a Kid Pix 2 picture that talks. 

ColorMe Co lorMe . . . 3§G 

ColorMes are special files that work like pages out of an electronic 
coloring book. There are lots of goofy, fun pictures that come with 
Kid Pix 2. They are particularly helpful for younger children who 
may be uncomfortable starting with a blank screen. Each is 
beautifully designed to inspire a child's creative abilities — to 
encourage her to experiment with different colors and patterns to 
make her very own work of art. Here's how they work: 

• Select ColorMe from the Switcheroo Menu, and a list of 
ColorMe folders will appear on the screen. 

• Select a ColorMe folder and open it by double-clicking on the 
folder name. Kid Pix 2 provides two ColorMe folders. Open one of 
these folders. 



• Select a picture to color from the list by double-clicking on the 
file name. You'll be taken back to the Kid Pix 2 drawing screen, and 
the picture you have chosen will be displayed. 

• Use the Kid Pix 2 paint tools and Rubber Stamps to decorate 
your picture. 

TIP: Try using the "Fill Bucket" tool first 
you want to color and click within the lines 

Choose an area 
If you click on any of 

the black lines that comprise the original ColorMe picture with the 
Fill Bucket, that line (and any lines connected to it) will become the 
color you have selected. 

TIP: Use the Wacky Pencil that looks like this to color over 
a ColorMe picture translucently without erasing any of it. 

When you are done, save your picture and give it a title, by selecting 
Save from the File menu. Don't worry, you can never wreck the 
original ColorMe pictures Kid Pix 2 provides. Kid Pix 2 will 
always keep the ColorMe picture in its original form, ready to be 
used over and over. 

• You may print out your ColorMe picture to share with family 
and friends, and you may use it as an element of a slide show, if you 
like. You can also print out ColorMe pictures without filling them 
in to create your own paper coloring book, and then color them 
with crayons or colored marking pens. 

W a c k y TV X£i W a c k y TU... 9€V 

The Wacky TV is where you can play QuickTime movies in Kid 
Pix 2. The controls are very similar to a VCR, except that they 
offer lots of goofy special effects. You can even paste a QuickTime 
movie right into your Kid Pix 2 picture so it looks like the movie is 
seamlessly blended into your picture. 

Kid Pix 2 includes QuickPix, a sampler of small movies to get you 
started, but you can use QuickTime movies from many sources 
including Macintosh user groups and bulletin board services. 

To use the Wacky TV: 
• Select Wacky TV from the Switcheroo menu and the Wacky TV 
will appear on the screen. Along will come a dialog box with a list 
of QuickTime movies. If they aren't right there in the dialog box, 
you will have to navigate to the folder called QuickPix. 



• Select the movie you want to run by double-clicking on the title of 
the movie. You'll be taken back to the Wacky TV, and the opening 
frame of the movie will be displayed on the screen. The control ^"N 
buttons to run the movie are as follows. 

This is the Channel Changer. If the movie playing in the Wacky TV 
isn't the one you want, just click on the Channel Changer and a 
dialog box will appear where you can pick a new one. 

This is the Stop button. It stops the movie in your Wacky TV. 

This is the Goodbye button. It removes the Wacky TV and 
QuickTime movie from the Kid Pix 2 screen. 

Start the movie by clicking on the Play button. The movie will play 
right there on your computer in the Wacky TV! It will play through 
in a loop. 

This is the Step-by-Step button. It moves the movie forward one 
frame at a time. 

To replay the movie, click on the Rewind button. When the 
opening screen of the movie appears, click on Play to start the 
movie again. 



The Electric Mixer in the Wacky TV does the same kind of thing to 
your QuickTime movie that it does to your Kid Pix 2 picture: in Kid 
Pix 2, it mixes it up like a kookie egg beater! Click on it and it'll 
bring up eight zany special effects you can use to play with the 
movie. They are: 

EEPIY! Play your movie backwards! 

Stroboscope! The TV set goes on the fritz (but not really)! 

Zoomer! Zooms in on the movie. To zoom out, press the Option 
key when you click on the Zoomer button. 

Speedo! Plays the movie super fast. 

Splash! Lots of dancing dots scatter across the movie. 

Shatter! The movie shatters like a piece of broken glass. 

Searchlight! A roving square searches all over the movie. 

Checkerboard! The movie breaks up into lots of little squares. 

If you want to undo a special effect while it is playing, just click on 
the Undo Guy. 

Paste a 
QuickTime 
M o v i e into a 
Kid Pix Picture 

Perhaps the most magical feature of the Wacky TV is that you can 
make it go away! When you are viewing a QuickTime movie in the 
Wacky TV, and you'd like to paste it in the picture without the 
Wacky TV, here's what you do: 

• Click on the Paste Jar button. 



• The TV set will go away and a freeze-frame of the movie will be 
"stuck" to the Paste Jar. 

• The movie will be ready to paste anywhere in your Kid Pix 2 
picture by moving the mouse. 

• Just drag the picture with your mouse where you want it, then 
click once to paste it into your picture. 

Play M o v i e P l a y MoLi ie :#:U 

• You can play the movie at any time by choosing "Play Movie' 
from the Switcheroo menu. 

• You will also regain control of the Kid Pix 2 painting tools and 
the Menu Bar. 

Now you can save your Kid Pix 2 document at this time - with a 
movie in it! 

TIP: Once you have pasted a QuickTime movie into your Kid 
Pix 2 picture, you can use the Kid Pix 2 painting tools to color 
around the movie and make it blend into your picture. Each of the 
QuickPix provided with Kid Pix 2 has a background color exactly 
the same as one of the colors in the Kid Pix 2 color palette. So you 
can paint around the movie to make it meld seamlessly into your 
picture. 

Play a 
N e w M o v i e 

If you have already pasted a movie in a picture and you want to 
play a new movie, 

• Select Wacky TV from the Switcheroo menu. 

• Select a new movie from the dialog box. 

• Play the movie. 

Paste a N e w After playing this new movie in the Wacky TV, you can paste it into 

M o v i e l n t © W y o u r p i c t u r e - H e r e ' s h o w : 

Your Picture • Click on the Paste Jar to make the Wacky TV go away. 

• Paste the movie into your picture. 

• Only one movie can be pasted into a Kid Pix 2 picture at a time, 
so the new movie will replace the old one. 



S a v e Your You can save a Kid Pix 2 picture with a movie inside it! Just select 
Picture With A Save As from the File menu and choose " Save QuickTime Movie 
M o v i e Inside It with Picture." The next time you open your picture, the movie will 

start playing right away! Be sure to keep the movie you used to 
paste in your picture in the same folder as your Kid Pix 2 picture. 

Switch To 
S l ideShow wtf Swi tch to S l ideShom 

To use the Kid Pix 2 SlideShow, choose "Switch to SlideShow" from 
the Switcheroo menu. You will need 3MB of available RAM to use 
the switch. 



Let's Make a 
Slide Show 

Before we begin, be sure you have the pictures you want to select 
for each of the slides for SlideShow. These can be drawings created 
with Kid Pix 2, including DrawMe pictures and ColorMe pictures, 
or any artwork in PICT format. 

H o w to Start SlideShow is a separate program, and can be launched by double-
clicking on its icon, or by choosing "Switch to SlideShow" from the 
Switcheroo menu in Kid Pix 2. 

Slide Show 

The SlideShow title screen will appear, followed immediately by a 
group of empty Moving Vans. Each one of these Moving Vans can 
carry a picture or "slide" as well as a sound and a transition to the 
next slide. These are special Moving Vans that you drag or "drive 
around," to put the slides in whatever order you want. Since this is 
Kid Pix 2, and the best companion we know of is a dog, these vans 
are all driven by the Kid Pix 2 Dog, Tom. Don't be nervous that we 
put a dog behind the wheel of a truck. Our puppy has a special dog 
license for driving SlideShow Moving Vans and a perfect driving 
record. 



Anytime you click on a Moving Van, it becomes highlighted in a 
lovely pale blue, and Tom will look at you to let you know he's 
paying attention. 

Note: If you have a 13" monitor, twelve numbered SlideShow 
Moving Vans will be displayed in each panel. If you have a 9" or 
12" monitor, you will see nine numbered Moving Vans. You can 
bring more vans into view by clicking on the down arrow at the 
lower right of the screen. There are 99 vans in all! 

There are four tools you may use to fill the Moving Vans for your 
slide show. Let's take a look at them one by one. 

Pick a Picture! E l 
• Begin by clicking on the Picture icon (it looks like a photo slide) 
on the Moving Van where you want to place a picture (probably the 
first one since you're just getting started). 

When you select this option, the Pick A Picture! dialog box comes 
up. If you picked the first Moving Van to place a picture in, notice 
that "Slide #1" is displayed, indicating that this picture will be 
placed in Moving Van 1 on the SlideShow screen. 



Pick a Picture! 
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TIP: It's a good idea to keep all the pictures for one show in the 
same folder. Then, when you are picking pictures for the slide 
show, they can be found in one place. 

• When you have decided which picture you want, click on Select to 
load the file into SlideShow. The Pick A Picture! dialog box will go 
away. The picture will be placed in the first Moving Van and will 
be ready as the first picture in your slide show. 

• To choose a second picture file, just click on the Pick A Picture! 
button (the one that looks like a slide, remember?) of the second 
Moving Van. Repeat the above steps to load the second picture into 
SlideShow. 

• You can also select a QuickTime movie, including one of the 
QuickPix, in the same way you can select a picture. Just click on a 
movie title as you would a picture title and the movie will be placed 
into the appropriate SlideShow Moving Van. 

• At any time, you may double-click on a Moving Van to see a full 
screen preview of your drawing, including whatever sounds you 
may add to it and any transition effect you may have included. 

Pick a S o u n d ! SlideShow comes with a set of musical pieces ready-made for your 
enjoyment. They are original mini-sound tracks using the 
wonderful world of Kid Pix 2 sounds. You can add them to any 
picture. Or, if you have a system equipped with a microphone, you 
may add sounds of your own creation. 

The Pick A Sound! icon looks like a musical note. Click once on the 
note to bring up the Pick A Sound! dialog box. 



Wacky 
Compositions 

Wacky, 
Sounds 

Revert to original 
Kid Pix sound 

, , / 

Pick a S o u n d ! 

Pre Hie in 

Select ) 
Cancel 

Record your own N o sound 

After previewing the sounds and deciding which sound you want, 
click on the Select button to place the sound in your Moving Van. 
You'll be returned to the SlideShow screen. The hole in the note of 
the Pick a Sound! icon, which was empty, will now be filled to show 
that you have added a sound to that Moving Van. 

Note: If the picture you selected to include in your slide show 
already had sound recorded with it from Kid Pix 2, the empty note 
icon will automatically change to a filled note to indicate that there 
already is sound with the picture. Of course, you can still go to Pick 
a Sound! and select a new sound to go over the old one. And if you 
decide you want the old Kid Pix 2 sound back, just click on the Kid 
Pix 2 button. 
still have the o 

EID P IX 

4») If you open the picture back in Kid Pix 2 it will 
d sound. 

Note: If you select a QuickTime movie to include in a Moving Van, 
sound cannot be added and the Pick a Sound! button will be grayed 
out. 

Pick a 
Transition! 

A Transition is a graphic way of going from one slide to the next. 
SlideShow automatically adds a default transition to each slide 
called a Cut. You can choose from many other effects. Just click on 
the Transition icon to get to the Pick a Transition! dialog box. 



| £ | Pick a Transition 
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The buttons for each of the transition effects work in a similar 
fashion to the Pick A Sound! buttons. 

• Select a Transition effect, then click on the Preview button to see 
what it looks like. When you find the Transition effect you want, 
just click on Select to load it into a SlideShow Moving Van. 

Here are the different transitions you can use : 

Wipe Left! 

± 



Wipe Down! 

Wipe Right! 

Bubbles! 

Shatter! 

mm 
Panel Drop 

Venetian Blinds! 

+ ;:;: + 

Barn Doors Open! 

£ 3 
Garage Door! 

Zipper! 

Sweep Away! 



The Time The Time Slider allows you to control the amount of time that 
Slider elapses between slides. The slider is automatically set at 3 seconds, 

unless the sound chosen for the Moving Van is longer. Then the 
Time Slider will increase to reflect the length of the sound. The 
Time Slider may be decreased to 0 seconds and increased to 30 
seconds. To do this, use the Time Slider located along the bottom 
of each Moving Van. 

• Move the Time Slider by clicking on it, holding down the mouse 
button, and dragging it to the right or left. 

A digital watch face will appear and show the time each slide will 
be displayed. Once you've fine-tuned the speed of your 
presentation to your satisfaction, be sure to save your work. 

TIP: Once you've set-up your slide show, you still might want to 
go back and play with, or "tweak," the length of each slide by 
adjusting the Time Slider. For example, if your slide has text, you'll 
want to make sure people have enough time to read it. 

The 
S l ideShow 
Control Panel At the bottom of the SlideShow screen is a Control Panel that lets 

you edit and play your SlideShow presentation. 
Here's what each button does: 

• If you've created a slide and find that you don't like it and would 
like to start again from scratch, select the Moving Van by clicking 
on it, and then click on the Firecracker. The Moving Van's contents 
will be emptied. 

• If you change your mind about emptying the Moving Van, you 
can click on the Undo Guy and the contents will magically reappear. 
In fact the Undo Guy will undo any last action you have taken at 
any point in your preparation of your slide show. 



• Click on this icon to Play the slide show through once. 

• Click on this icon to Play the slide show in a continuous loop. 

There are other ways to modify your slide show: 

• To pause the SlideShow when it is playing, press the Spacebar. 

• To exit a slide show at any time while it is playing, double-click 
the mouse or press §§-period. 

• Press the mouse button while a slide is playing to go to the 
Transition. 

• Press the mouse during a Transition to go to the next slide. 

TIP: To "step through" at your own pace, hold down the option 
key and click on the play button. The first slide will be displayed. 
Click the mouse once to step through each subsequent slide. 
Here are a couple of things you can do while playing a QuickTime 
movie in a SlideShow: 

• Use the Shift key to slow down the speed of the QuickTime 
movie. 

• Use the Command key to speed up the QuickTime movie. 

Slide S h o w After you have created a slide show, you may find that you want to 
put the Moving Vans in different sequence, add new vans, or 
eliminate some of the vans altogether. SlideShow gives you several 
options for editing your project. 

• To drive a full Moving Van (a van with a Picture and/or Sound 
and/or Transition in it) to another place in the SlideShow, click and 
drag it to the new location. You will hear the van start up, the 
engine run, and the tires "peel out." 

If you move a full Moving Van onto another full Moving Van, that 
Moving Van is always nudged to the right. It will then "bump" any 
other vans in the sequence over one frame to the right. 

When you remove a Moving Van from its parking place, it always 
leaves behind an empty Moving Van. 



If you park a full Moving Van on top of an empty Moving Van, the 
full Moving Van will replace the empty one. 
In the process of relocating your Moving Vans you may find that 
you have left one or more empty Moving Vans in your slide show. 

• To remove the empty Moving Vans, just select Clean Up from the 
SlideShow Goodies Menu and the empty vans will be discarded. 
But even if you play your SlideShow with the empty vans in place, 
the program will skip over them so that the sequence of your 
presentation will not be interrupted. 

TIP: For the first slide in your slide show, it's sometimes a good 
idea to start with just a plain screen of color. Use the Fill Bucket in 
Kid Pix 2 to create a " blank" picture, all one color. Select that 
picture for the first Moving Van. Then, if you select a transition to 
move into the next picture, which is actually the first picture you 
have drawn for the show, it will look like that picture emerges from 
a matching background. 

Sl ideShow 
M e n u s Now let's go over each of the menu features. 

File M e n u Each of the options on this menu, except Save As, may also be 
selected from the keyboard as well as with the mouse. The keys to 
press are shown next to each menu option. 

N e w 3§N 

If you have been working on another slide show and choose to 
create a new show, you'll be given the chance to save any changes 
you have made. A new slide show screen with empty Moving Van 
frames will be displayed. 

O p e n . . . :#:0 

This lets you open a saved slide show. Select the file you want from 
the list on the screen. 

Note: If SlideShow files can't be located by the computer, a dialog 
box will come up telling you that the file or files you want to open 
can't be found. If this happens, you should return to the Moving 
Van that held that slide and attempt to relocate it. Use the dialog 
box to navigate to where your misplaced file is, and double-click on 
the name of the file. If you cannot find your picture, SlideShow will 
display the little thumbnail version in its place. 



C l o s e 

This will close the SlideShow on the screen. The program will ask 
you if you wish to save your work. If you do not choose Save, any 
changes you have made will not remain in your slide show. 

S a u e 3§S 

This saves the SlideShow currently on the screen. If you haven't 
already given your project a title, the program will ask you to do so 
before saving. 

S a u e fls... 

You can save a Kid Pix 2 SlideShow as a regular presentation to run 
on your computer as described above, or you can make a self-
running StandAlone slide show disk that you can give to family and 
friends (assuming they have a Macintosh computer). And finally 
you can make a QuickTime movie of your SlideShow presentation 
that can be used by anyone with QuickTime. 

When you select Save As, a dialog box will present you with the 
following options: 

F o l d e r F i l e D r i u e O p t i o n s G r o u p 

| S i K i d P i n C o m p a n i o n • | 

D iii>ta 4 S u b m i s s i o n m e m o 

D B O M 

D I! a s a p a n s a s D a t a 

• C r e a t i n e I J J o r k P l a n s 

• D i r e c t o r flnims 

• D i s k S p a c e A l l o c . 

LJ D o c u m e n t a t i o n 

• D o g s h o w 

D D r n w M e f D a t a 

S a u e s l i d e s h o u j . 

U n t i t l e d S l i d e S h o w 

® N o r m a l 

O S t a n d f l l o n e s l i d e s h o u j 

O Q u i c k T i m e ™ m o u i e 

i U n i m i n d 

1 E j e c t ) 

[ D e s k t o p ] 

L C a n c e l ] 

(?) N o r m a l 

To save a slide show in the standard way, select Normal. You will 
need the application SlideShow to run this type of slide show. 



® S t a n d A l o n e s l i d e s h o i u 

To create a StandAlone slide show: 

• Select Save As . . . from the SlideShow File menu. 

• When the dialog box appears, click on the StandAlone slide show 
option. 

Kid Pix 2 will then save vour StandAlone slide show with an icon 

that looks like this: B E Double-click on this icon to run your 
AS 

slide show as a self running presentation. 

• To save your slide show to a floppy disk, place a formatted disk in 
the floppy drive. If you have any questions about formatting 
Macintosh disks, see your Macintosh User's Manual. 

• Select Save As . . . from the SlideShow File menu. Click on Drive 
to locate the formatted floppy disk, and select the StandAlone slide 
show option, then click on Save. Your SlideShow will be saved 
(plus the information it needs to run independently of SlideShow) to 
the floppy disk. 

TIP: Make a label for your floppy disk and you are all set to share 
your creations with family and friends. You can make as many 
copies of your StandAlone slide show disk as you like. 

(•) Q u i c k T i m e ™ m o u i e 

Another option you have when you save a slide show is to save it as 
a QuickTime movie. QuickTime is a new technology that (among 
other things) makes it super simple to take slide shows that you 
make with Kid Pix 2 and include them in any other application that 
supports QuickTime. For example, Kid Pix 2 supports QuickTime 
through its Wacky TV. If you save your slide show as a QuickTime 
movie, you can play it back in the Kid Pix 2 Wacky TV! 

Kid Pix 2 includes QuickPix, a sampler of small movies to get you 
started, but you can use QuickTime movies from many sources 
including Macintosh user groups and bulletin board services. 

When you save a slide show as a QuickTime movie, you can quickly 
and effortlessly play the movie on the Wacky TV in Kid Pix 2. For 
more about the Wacky TV see Page 39 of this manual. You can also 
place the QuickTime movie you create into a document in another 
program that has QuickTime with just a few clicks of the mouse. 
It's just as easy as copying and pasting text and graphics. 



To Save a slide show as a QuickTime Movie: 

• Select Save As . . . from the SlideShow File menu. 

• When the dialog box appears, click on the QuickTime movie 
option. SlideShow will then save your slide show as a QuickTime 
movie. 

Quit m 

This closes your SlideShow file. You'll be reminded to save your 
work, if you haven't already done so, before leaving the SlideShow. 

Edit 
M e n u 

This is just like the Undo Guy and will Undo the last action you 
took. 

C u t # K 

This feature will let you cut all of the contents (picture, transition, 
sound) of a Moving Van to the Clipboard, leaving behind an empty 
Moving Van. Please note that the Moving Van you want to Cut 
must be selected by clicking on it, or the Cut function won't work. 

C o p y :#:C 

Choose this to make a copy of all the contents of a Moving Van to 
the Clipboard leaving the selected Moving Van still parked in the 
frame. Again, this function only works if you have clicked on the 
Moving Van first to select it. 

Eg P a s t e # U 
Anything that you have cut or copied to the Clipboard will be 
pasted into the selected Moving Van. 



Goodies M e n u 

Goodies 

Play Once :#:U 

| * ^ | Play Looped 3€L 

Clean Up 

y •̂>>) Tool Sounds :#:T 

(}̂ p Background Color 

v;> Suiitch To Kid PiH 2 

• P l a y O n c e # U 

Choose this option to run your slide show through one time. 
Hold down the option key while selecting this to step-through. 
Each time you click the mouse you will go to the next slide. 

P l a y L o o p e d :#:L 

Select this option to play your slide show in a continuous loop. 

To pause the play, press the Spacebar. To exit play, click the mouse 
twice. 

C l e a n Up 

When editing your project, you may move things around in such a 
way that you end up leaving one or more of the Moving Vans 
empty. To remote the empty Moving Vans, just select Clean Up 
from the Goodies Menu and the empty vans will be discarded. But 
even if you play SlideShow with the empty vans in place, the 
program will ski]? over the empty frames so that the sequence of 
your presentation will not be interrupted. 

>>) Tool S o u n d s 

Lets you turn off 
back on simply 

SlideShow sound effects. To turn tool sounds 
select "Tool Sounds" again. 

J c r B a c k g r o u n d C o l o r 

You can pick a 
show are smaller 

^ > s w i t c h 

back 

To K id PiK 2 

Use this to switch 

3€T 

ground color to use when elements of your slide 
than the entire screen. 

back to Kid Pix 2. 

H o w to P lay 
QuickTime 
M o v i e s in 
S l ideShow 

You can put a 
part of your slide 
Moving Vans, and 

QuickTime movie in a Moving Van and have it be 
show. You can put up to 99 movies into the 
intermix movies with still pictures. 



Here's how to get QuickTime into your slide show: 

QuickTime™ Options 

Loop 5 times 

• Double Size 

Cancel ] | OK J 

• Click on the Pick A Slide! button on the Moving Van frame where 
you wish to place the QuickTime Movie (including QuickPix). 

• Select the title of the movie you want to put in the SlideShow 
Moving Van. You'll be returned to the SlideShow screen and a 
thumbnail representation (called a "Poster") of the movie will 
appear in the Moving Van you selected. 

• Double-click on the Moving Van frame to preview the movie you 
selected. 
• Hold down the Command key to speed up the movie while it's 
playing. 

Clicking on the Time Slider normally tells you how many seconds a 
picture displays on the screen, and allows you to adjust that length. 
If you place a QuickTime movie into a Moving Van, however, 
although you cannot adjust the movie length, you can still click on 
the Time Slider to see how long it will play. Because you cannot 
adjust its length, however, the Time Slider will not be able to move. 

If you have a QuickTime movie in a Moving Van, holding down the 
option key and clicking on the Time Slider allows you to select 
features unique to QuickTime: how many times the movie will loop 
and whether the movie should play at twice the size. You can also 
select the number of times a movie embedded in a Kid Pix 2 picture 
can loop by holding down the option key and clicking on the Time 
Slider. 

H o w to Use 
S l ideShow to 
Create Fun 
Animat ions 

Create a sequence of pictures in Kid Pix 2, such as an airplane flying 
across the sky, and load that sequence of pictures into SlideShow to 
create an animation that's fun to watch! Here's what you do: 

• Create a folder inside your Kid Pix 2 folder and name it 
"Cartoon" (for example). 

• Open up Kid Pix 2 and create the first picture in your series of 
animations. 

• Save that picture as " Cartoon 1" into your Cartoon folder. 

• Change the picture slightly to reflect the next movement you want 
displayed. 

• Choose Save As . . . from the File menu and save the picture as 
" Cartoon 2" into the Cartoon folder. 

• Alter the picture slightly again and choose Save As . . . and save it 
as "Cartoon 3." 



• Continue to make these pictures until your animation is done! 

• Launch SlideShow. 

• Put each cartoon into the Moving Vans, one at a time. 

transition for each Moving Van. 

• Set your Time Slider to 0 seconds for each Moving Van. 
• Choose Play and enjoy your SlideShow animation. 

• Save your slide show as a QuickTime movie, if you like, and open 
it later in the Kid Pix 2 Wacky TV - it will play even faster! Play it 
with Electric Mixer effects or paste it seamlessly into a Kid Pix 2 
picture for multimedia fun. 

Choose the Cut 
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Kid 
Pix 2 
Notes 

Bigger Color 
Cells 

To make the colors bigger in the color palette, go to the Control 
Panel and set your monitor to "16 colors." Small children may 
find large colors easier to click on. 

Kid Pix a n d 
Monitors 

Press the spacebar when booting Kid Pix 2 and the drawing 
screen will enlarge to take advantage of monitors larger than 
13". You may have to increase your application memory if you 
have a larger monitor. Highlight the Kid Pix 2 icon and choose 
"Get Info" from the File menu. Increase the Current size or 
Preferred size by 500K or more. 



Compatibility • Memory Compatibility 

Kid Pix 2 and SlideShow each require 1464K of free RAM 
(Random Access Memory) for color systems to run. This means 
that no matter how much RAM you have installed on your 
Macintosh, if any other applications you have open leave you 
with less than 1464K free, you might run into problems. So if 
you are having problems, click on the Apple icon in the top left 
corner of your screen and pull down the menu selection "About 
the Finder . . . " Look under "About This Macintosh" to see if 
you have enough free memory. If not, turn off your INITs, quit 
other programs running at the same time, or buy some more 
memory. 

• QuickTime Compatibility 

QuickTime requires a 68020 microprocessor or better, 32-bit 
Color QuickDraw, and System 6.0.7 or greater. If your system is 
an SE or Plus, QuickTime won't work on it. Our installer will 
check to see what kind of Macintosh you have and if it isn't 
compatible with QuickTime then the QuickTime features of Kid 
Pix 2 won't be installed. If your machine is capable of running 
QuickTime, the QuickTime INIT will be installed in your System 
folder. 

SlideShow can work in 1-bit, 4-bit, or 8-bit monitor modes. 
When opening a slide show be sure you are in the same monitor 
mode that was used when creating the file. However, a Stand­
Alone slide show can be played on any monitor and in any mode 
regardless of the mode in which it was created. 



Br0derbund ' s Limited Ninety-Day Warranty 

Braderbund warrants for a period of ninety (90) days following the original retail purchase 
of this copy of Kid Pix 2 that the program is free from substantial errors or defects that will 
materially interfere with the operation of the program as described in the enclosed user 
documentation. This policy applies to the initial purchaser only. 

If you believe you have found any such error or defect in the program during the warranty 
period, call Braderbund's Technical Support Department at 415/382-4700 between the hours 
of 7 a.m. and 5 p.m. (Pacific Time), Monday through Friday. Braderbund technical 
personnel will attempt to help you correct or avoid the problem. If any such error or defect 
cannot be corrected or reasonably avoided, Braderbund will inform you how to obtain a 
corrected program disk (or, at Braderbund's option, Braderbund may authorize a refund of 
your purchase price). 

This warranty gives you specific legal rights, and you may also have rights which vary from 
state to state. 

Disk Replacement Policy 

If any disk supplied with this product fails within ninety (90) days of purchase for any 
reason other than accident or misuse, please return the defective disk together with a dated 
proof of purchase to Braderbund Software-Direct®, P.O. Box 6125, Novato, CA 
94948-6125, for a free replacement. This policy applies to the original purchaser only. 

Braderbund will replace program disks damaged for any reason, whether during or after the 
ninety (90) day free replacement period, for a minimal fee. For more information, please 
contact BraderbundCustomer Service at 415/382-4600. This policy will be followed as long 
as the program is still being manufactured by Braderbund. 

Limitations on Warranty 

Unauthorized representations: Braderbund warrants only that the program will perform as 
described in the user documentation. No other advertising, description or representation, 
whether made by a Braderbund dealer, distributor, agent or employee, shall be binding upon 
Braderbund or shall change the terms of this warranty. 

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, BR0DERBUND 
MAKES NO OTHER WARRANTY, EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT. BR0DERBUND DISCLAIMS ANY WARRANTY THAT THE SOFTWARE IS 
FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF 
MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF 
THIS LIMITED EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND 
SPECIFICALLY DISCLAIMED. SOME STATES DO NOT ALLOW LIMITATIONS ON 
HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY 
NOT APPLY TO YOU. 

NO CONSEQUENTIAL DAMAGES: BR0DERBUND SHALL NOT BE LIABLE FOR 
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF 
BR0DERBUND IS ADVISED OF OR AWARE OF THE POSSIBILITY OF SUCH 
DAMAGES. THIS MEANS THAT BR0DERBUND SHALL NOT BE RESPONSIBLE OR 
LIABLE FOR LOST PROFITS OR REVENUES, OR FOR DAMAGES OR COSTS 
INCURRED AS A RESULT OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR 
FROM ANY OTHER CAUSE EXCEPT THE ACTUAL COST OF THE PRODUCT. IN 
NO EVENT SHALL BRODERBUND'S LIABILITY EXCEED THE PURCHASE PRICE OF 
THIS PRODUCT. SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. 

You are entitled to use this product for your own use, but may not sell or transfer 
reproductions of the software or manual to other parties in any way, nor rent or lease the 
product to others without the prior written permission of Braderbund. You may use one 
copy of the product on a single terminal connected to a single computer. You may not 
network the product or otherwise use it on more than one computer or computer terminal at 
the same time. 

For technical support, on this or any other Braderbund product, call 415/382-4700. 
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Broderbund 

For more information about Broderbund Software and our products, write to us at 500 Redwood Blvd., Novato, California 94948-6121. 
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